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The "KNOW BEFORE YOU GO" section includes important items for your office to review PRIOR
TO UPDATING to this new version. Look for screen, table and other changes that might affect your
workflow. (X Items with a red X are additional important items.

Items marked (Request) were requested by clients and satisfied in the associated update.

Click here to access enhancement details for Documents, EHR Screens and Smart Functions. This
Content Catalog is evolving, covering changes since Version 12.2, and is updated frequently.

Visit the Education Page for Psych on the Compulink Client website for additional resources.

For any questions or comments regarding this documentation, please email the Documentation
department at: documentation@compulinkadvantage.com

The topics in the Table of Contents contain links; click a topic to jump to that spot in the document.
Click on the red page number at the bottom right of the page to return.
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KNOW BEFORE YOU GO

X (12/23/2022)(12.6.0.16) Hot Topic >Display > GUI Update

e GUI stands for 'Graphical User Interface', and is pronounced 'gooey'.
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KNOW BEFORE YOU GO

o It is the user interface that includes graphical elements, such as windows, icons and
buttons.
e Version 12.6 contains a refresh of our GUI, bringing the 'look and feel' of the screens to
the latest GUI 'norm’.
e It includes updates to the color/font scheme and rounded edges on fields and
panels.
e We worked with an outside consultant specializing in GUI design, and we hope you
are excited about this new look as we are.
e Other default changes:
e Active Record in Grids:
e The active record in the grid is highlighted and will no longer display the
arrow to the left.
¢ This reduces clutter and allows more room in the grid.

Hot Topics

(12/28/2022)(12.6.0.16) Patient > URGENT: Text Messaging Update

*** Deadline of 1/6/2023.
* You should have already received an E-mail from Compulink regarding this matter.

e Telecommunications carriers such as Verizon, AT&T, T-Mobile, etc. are required to update
their technology to the industry standards for A2P 10DLC.

e A2P 10DLC refers to a system in the United States that allows businesses to send
Application-to-Person (A2P) type messaging via standard 10-digit long code
(10DLC) phone numbers.

¢ This update requires Compulink clients to provide additional business identifying
information, including the Tax Filing Business Name and Tax ID.

e Each outgoing phone number texting from the Compulink Advantage software requires
verification NO LATER THAN 1/6/2023.

¢ To continue to use our FREE built-in texting, you are required to fill out the form at this
link: https://new.advantageedi.com/p/g.dll/$/Start

o If your phone number is not verified with your business associated to it by 1/6/2023, you
will most likely experience a high rate of failed delivered text messages.

(9/7/2022)(12.6.0.16) Version 12.6 > Overview

e Contemporary healthcare standards are advancing rapidly with the latest legislative
mandates.

e Version 12.6 is our 21st Century Cures Act edition of the Advantage EHR software.

e With it, Compulink has added interoperability features which allow patients to gain full
access to their own health records using an app of their choice, and which benefit clinical
workflows and efficiencies to support quality care.

¢ Although your first look at Version 12.6 won't reveal a lot of shiny new features for the
office as in past versions, that belies the rich complement of features added behind the
scenes as discussed below.

¢ Building upon our existing 2015 Edition ONC Certification, Version 12.6 adds the
following:
e An API (application programming interface) based on the new HL7 FHIR (Fast
Healthcare Interoperability Resources) standard.

e This is the standard for exchanging EHR records and is what allows
independent developers to write apps that can access your patients'
records, upon request.

¢ Adoption of new networking principles, interoperability standards and security
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Hot Topics

protocols to ensure the exchange of patient information is protected and secure.

e New data elements compliant with United States Core Data for Interoperability
(USCDI).

e New data fields in various screens required to satisfy advanced documentation
requirements.

e Enhancements to the CDA to include new data elements such as USCDI.

e New tools and resources to comply with Information Blocking requirements and
much more.

(12/23/2022)(12.6.0.16) Display > GUI Update

e GUI stands for 'Graphical User Interface’, and is pronounced 'gooey"'.
o It is the user interface that includes graphical elements, such as windows, icons and
buttons.
e Version 12.6 contains a refresh of our GUI, bringing the 'look and feel' of the screens to
the latest GUI 'norm’.
e It includes updates to the color/font scheme and rounded edges on fields and
panels.
e We worked with an outside consultant specializing in GUI design, and we hope you
are excited about this new look as we are.
¢ Other default changes:
e Active Record in Grids:
e The active record in the grid is highlighted and will no longer display the
arrow to the left.
¢ This reduces clutter and allows more room in the grid.

(12/21/2022)(12.6.0.16) Documentation > 21st Century Cures Act
e As of December 13th, 2022, Compulink is officially 2015 ONC Cures Update Certified.

e The 21st Century Cures Act (Cures) is a bipartisan healthcare legislation enacted in
December 2016 to provide patients and their healthcare providers secure and
unrestricted access to their health information, by allowing patients control of when,
where and how their health information is accessed.

e The Cures Act provides a regulatory framework for the Office of the National
Coordinator (ONC) to enact rules designed to prohibit information Blocking by certain
“Actors” and foster interoperability of Health Information Technology systems. These
“Actors” include health information networks, HIEs, health information technology
developers of certified health ID and healthcare providers.

e The goal is to empower patients with seamless access to their health record through
technology that will deliver transparency into cost and outcomes, use of modern
smartphone apps and an economy that provides access, innovation and choice. This
advance in rulemaking will modernize the healthcare system and benefit patients,
physicians, providers, payors, health information technology developers and other health
care stakeholders toward the future of modernization.

e To find all 21st Century Cures Act topics in this document, search for “"Cures”.

(12/21/2022)(12.6.0.16) E&M Coding > Consults

e The AMA Guidelines for 2023 E&M Coding include the following:
e Office or Other Outpatient Consultations for New or Established Patients.
¢ Advantage Version 12.6 contains the Coding Logic to review the Exam data entered and
suggest the appropriate Consult Code to be posted.
o Effective January 1st, 2023, if the Consult field is checked in the Exam, the E&M Coding
engine runs upon clicking the Fees command.
e Existing clients need to verify that the Consult Codes exist in their Services table.
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Hot Topics

(12/22/2022)(12.6.0.16) E&M Coding > Place of Service

e Beginning January 1st, 2023, the E&M Coding engine runs when the Fees command is
selected in an Exam that has one of the following Place Of Service:
e 11 - Office
e 12 - Home
e 13 - Assisted Living Facility
e 14 — Group Home
e 21 - Inpatient Hospital
e 23 - Emergency Room-Hospital
e 31 - Skilled Nursing/Extend Care
e 32 — Nursing Home
e 33 - Custodial Care Facility
e 54 - Inter Care Fac/Mentally Rtd
e 55 - Resid Subst Abuse TrmtFac
e 56 - Residential Treatment Ctr
e Prior to 1/1/23, the engine only runs for Exam POS=11.

(12/30/2022)(12.6.0.16) Exam > 2023 Quality Measures

e NEW 2023 Claim and Clinical Quality Measure entries were added to the database.
e Two NEW tabs were added for documentation: Quality Measures 2023 and Quality
Measures 2023 (HiRes)

(2/3/2023)(12.6.0.16) Patient > Patient Portal Updates

¢ Several new updates have been made to the Patient Portal that is accessed from
mysecurehealthdata.com
e Upon logging in, a new Help link is displayed above the Copyright.
e Use this to open the ‘My Secure Health Data Patient Portal’ help manual.
e The title bar at the top now has links to the areas below to allow for easy transition
without having to return to the Home screen.
e My Health Records
e Message My Provider
e Statements
e The ‘Feedback’ link on the title bar was moved to the new *‘My Account’ drop-down.
e The 'Settings’ drop-down was changed to ‘My Account’.
e Some items previously found under ‘Settings’ have been renamed:
e Account Profile > Legacy ‘User Information’
e Activity > Legacy ‘Activity History’
e Authorized Users > Legacy ‘Authorized Representative’
¢ Direct Share > Legacy ‘Recurring Data Sharing’
e Session Time-out > Legacy ‘Adjust Time-out Setting’
e Request Records Update > Legacy ‘Request Records Update’
e Feedback > Previously on the main title bar
e Application Registration > Under development
e Remove My Account > Legacy ‘Remove My Account’
e The ‘Check Balance’ option was removed, as this now displays on the title bar.
e My Health Records section
e Defaults to displaying records for the last 30 days only to allow for quicker loading.
e The View’ option allows for selecting a wider date range for viewing.
e Message My Provider section
e The user’s name displays at the top and offers a drop-down to select another
patient connected to the same E-Mail.
e The user can send a message to the Provider on behalf of another user.
e If another option is selected from the title bar (Example: My Health Records), it
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Hot Topics

reverts back to the user that is logged in, preventing them from viewing
information for the other user.
e Statements section
e No changes.

(12/29/2022)(12.6.0.16) Exam > Care Plan Documentation

e The Care Plan is a presentation of information that easily describes the services and
support being provided to the patient.
e Care plans are developed with the patient’s input; a ‘person centered’ Care Plan is
generally designed for patients with chronic conditions.

e A new Care Plan tab is available for documentation of items such as:
e Chronic Care Management Services, or Prolonged Services.
e Cognitive Assessment & Care Plan Services
e Chronic Pain Management (CPM)
e Advanced Care Plan and others

e From a QPP standpoint, Screening for Social Drivers of Health might be documented and
included in this area of the software.
e New Quality Measure 487: Screening for Social Drivers of Health

e Percent of patients 18 years and older screened for food insecurity, housing
instability, transportation needs, utility difficulties, and interpersonal safety.

e Documenting this information is a foundational step towards defining,
addressing, and allocating supportive resources to patients in a long-term
care plan.

e The Care plan requires information that includes the following data elements for exchange
of patient health information:
e Patient Name
e Goals
e Health Concerns
¢ Clinical needs
e Health Status Evaluations and desired Outcomes
e Interventions

Education

(4/28/2023)(12.6.0.16) Video > UPDATED: Patient Portal Update

e The Compulink University course 'Patient Portal Update’ was updated.
¢ It can be found under the following Program: Patient Portal

e Course Description: Learn about the latest update to the Patient Portal.
e Republished: 4/24/23 - Length: 2 Minutes

(4/28/2023)(12.6.0.16) Video > UPDATED: Portal: Patient Education Resources

e The Compulink University course 'Portal: Patient Education Resources’ was updated.

e It can be found under the following Program: Patient Portal

e Course Description: Learn about the new videos and online Help available to your patients
on the MySecureHealthData sign in page.

e Republished: 4/24/23 - Length: 2 Minutes

(4/28/2023)(12.6.0.16) Video > UPDATED: Tips for Billing Success

e The Compulink University course 'Tips for Billing Success' was updated.
¢ It can be found under the following Program: Billing: Insurance
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Education

e Course Description: Learn some practical tips for billing success with insurance claims and
patient statements.
e Republished: 4/24/23 - Length: 10 Minutes

(3/22/2023)(12.6.0.16) Video > NEW: Financial: Electronic Payment Setup Table

e The Compulink University course 'Financial: Electronic Payment Setup Table’ was added.

¢ It can be found under the following Program: Tables: Financial

e Course Description: Learn how to complete the Electronic Payment Setup table which
stores information for processing electronic payments from your patients.

e Published: 3/20/23 - Length: 4 Minutes

(3/22/2023)(12.6.0.16) Video > UPDATED: Receivables Advisor from Change
Healthcare

e The Compulink University course 'Receivables Advisor from Change Healthcare' was
updated.

¢ It can be found under the following Program: Billing: Patient

e Course Description: Learn how to request, install and set up Receivables Advisor services.
Review the process for preparing Recalls and Statements and how to transfer files using
the Filezilla software.

e Republished: 3/20/23 - Length: 13 Minutes

(3/22/2023)(12.6.0.16) Video > UPDATED: Revenue Codes Table

e The Compulink University course 'Revenue Codes Table' was updated.

¢ It can be found under the following Program: Tables: Financial

e Course Description: Learn how to populate the Revenue Codes table, used to store
Revenue Codes associated with Medicare Part A UB04 claims.

e Republished: 3/20/23 - Length: 3 Minutes

(3/14/2023)(12.6.0.16) Video > NEW: 2023 Medicare Part B Claim Submission of

Quality Measures

e The Compulink University course '2023 Medicare Part B Claim Submission of Quality
Measures’ was added.

¢ It can be found under the following Program: Govt Compliance

e Course Description: This course is designed for users submitting Quality Measures
through Medicare Part B claims. Learn how the Exam Quality tab connects to your
Financial Services table and how to add/update Quality Codes for the current year.

e Published: 3/10/23 - Length: 10 Minutes

(3/14/2023)(12.6.0.16) Video > NEW: AdvantageERx: Prescription Drug
Monitoring Program (PDMP)

e The Compulink University course 'AdvantageERx: Prescription Drug Monitoring Program
(PDMP)’" was added.

¢ It can be found under the following Program: E-Prescribing

e Course Description: Review the Prescription Drug Monitoring Program (PDMP) setup and
functionality.

e Published: 3/10/23 - Length: 6 Minutes

(3/14/2023)(12.6.0.16) Video > UPDATED: Claim Validate Tool

e The Compulink University course 'Claim Validate Tool' was updated.

¢ It can be found under the following Program: Billing: Insurance

e Course Description: Learn about the new Claim Validate field in System Setup in V12.6.
e Republished: 3/10/23 - Length: 2 Minutes

(3/14/2023)(12.6.0.16) Video > UPDATED: Portal: Registration And Logging In
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Education

e The Compulink University course 'Portal: Registration And Logging In' was updated.

e It can be found under the following Program: Patient Portal

e Course Description: This short video will explain the step by step process for how to
register and validate a patient account on the portal, from the patient’s perspective.

e Republished: 3/10/23 - Length: 2 Minutes

(3/14/2023)(12.6.0.16) Video > UPDATED: What is New in V12.6

e The Compulink University course 'What is New in V12.6' was updated.

¢ It can be found under the following Program: About Version 12.6

e Course Description: Take a look at new features and improvements in V12.6.
e Republished: 3/10/23 - Length: 22 Minutes

(2/27/2023)(12.6.0.16) Video > NEW: CMS Quick Start Guides

e The Compulink University course 'CMS Quick Start Guides’ was added.

e It can be found under the following Program: Govt Compliance

e Course Description: Learn how to quickly access the CMS Quick Start Guides for each
performance category. This is an easy way to familiarize yourself with the current
requirements.

e Published: 2/24/23 - Length: 2 Minutes

(2/27/2023)(12.6.0.16) Video > NEW: Reset Portal Accounts & Resend CCD
Process

e The Compulink University course 'Reset Portal Accounts & Resend CCD Process’ was
added.

e It can be found under the following Program: Patient Portal

e Course Description: Briefly review the process for resetting a patient’s portal account and
re-sending a CCD.

e Published: 2/24/23 - Length: 2 Minutes

(2/27/2023)(12.6.0.16) Video > UPDATED: Portal: Access Your Health
Information

e The Compulink University course 'Portal: Access Your Health Information' was updated.

e It can be found under the following Program: Patient Portal

e Course Description: Learn how to access and view health information your provider has
uploaded to your Patient Portal.

e Republished: 2/24/23 - Length: 2 Minutes

(2/27/2023)(12.6.0.16) Video > UPDATED: Running Diagnostics

e The Compulink University course 'Running Diagnostics' was updated.

¢ It can be found under the following Program: Practice Admin

e Course Description: This course will discuss running the Diagnostics Utility, walk through
the process and the files that are accessed. A review of the Diag.Log file and Auto
Diagnostics is included.

e Republished: 2/24/23 - Length: 14 Minutes

(2/27/2023)(12.6.0.16) Video > UPDATED: User-Focused Education in Your
Software

e The Compulink University course 'User-Focused Education in Your Software' was updated.

¢ It can be found under the following Program: elLearning Resources

e Course Description: Education items, filtered by your user profile are delivered right to
your Advantage desktop.

e Republished: 2/24/23 - Length: 4 Minutes
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Education

(2/17/2023)(12.6.0.16) Video > UPDATED: Portal: Message Your Provider

e The Compulink University course 'Portal: Message Your Provider' was updated.

¢ It can be found under the following Program: Patient Portal

e Course Description: Learn how to message your provider from within the Patient Portal.
e Republished: 2/13/23 - Length: 1 Minutes

(2/2/2023)(12.6.0.16) Video > NEW: System Setup: System Administrator Tab

e The Compulink University course 'System Setup: System Administrator Tab’” was added.

¢ It can be found under the following Program: Practice Admin

e Course Description: Establish practice rules related to User Passwords, Login Controls,
System Maintenance, Multi-Factor Authentication, PHI Audit Controls and more.

e Published: 1/24/23 - Length: 9 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Client Dashboard

e The Compulink University course 'APX: Client Dashboard” was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: This course shows an example of the Promptly Client Dashboard as it
appears once you've completed Implementation and Setup.

e Published: 1/24/23 - Length: 15 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Implementation Process Overview

e The Compulink University course 'APX: Implementation Process Overview’ was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: This presents a broad overview of what to expect throughout the
setup and integration process for Advantage Patient Experience, powered by Promptly.

e Published: 1/26/23 - Length: 5 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Recommended Daily Workflow

e The Compulink University course 'APX: Recommended Daily Workflow" was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Review a recommended daily workflow for Advantage Patient
Experience, powered by Promptly.

e Published: 1/26/23 - Length: 4 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Table Setup I

e The Compulink University course 'APX: Table Setup I' was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Learn to set up the Users and Users Groups tables on the Promptly
Admin site.

e Published: 1/24/23 - Length: 6 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Table Setup 11

e The Compulink University course 'APX: Table Setup II' was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Learn to set up the Configuration, Decision Tree and Mandatory Fields
tables on the Promptly Admin site.

e Published: 1/24/23 - Length: 19 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Table Setup III

e The Compulink University course 'APX: Table Setup III' was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Learn to set up the Broadcast, Questionnaire, Personal Message
Types and Follow-up Worklists Actions tables on the Promptly Admin site.
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e Published: 1/24/23 - Length: 9 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: APX: Table Setup IV

e The Compulink University course 'APX: Table Setup IV’ was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Learn to set up the Canned Messages, Manage Reply, Notifications,
Invitation Template and E-Mail Templates Tables in Promptly.

e Published: 1/24/23 - Length: 14 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: Advantage Patient Experience

e The Compulink University course 'Advantage Patient Experience’ was added.

¢ It can be found under the following Program: Advantage Patient Experience

e Course Description: Advantage Patient Experience, powered by Promptly, is an online
patient experience suite, designed to enhance patient touchpoints, increase payments
and automate processes. Here’s a brief look at some of the available features.

e Published: 1/26/23 - Length: 3 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: Claim Validate Tools V12.6

e The Compulink University course 'Claim Validate Tools V12.6" was added.

¢ It can be found under the following Program: Billing: Insurance

e Course Description: Learn about the new Claim Validate field in System setup and the
Ledger Validate function added to PracticeWatch in V12.6.

e Published: 1/26/23 - Length: 2 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: System Setup: AP/GL Tab

e The Compulink University course 'System Setup: AP/GL Tab’ was added.

e It can be found under the following Program: Practice Admin

e Course Description: Learn where to set up information for the internal Accounts Payable
and General Ledger features.

e Published: 1/24/23 - Length: 2 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: System Setup: Acct. Billing Tab

e The Compulink University course 'System Setup: Acct. Billing Tab’ was added.

e It can be found under the following Program: Practice Admin

e Course Description: Learn where to set parameters for patient statements, finance
charges and overdue notices, and establish default messages for receipts and
statements.

e Published: 1/24/23 - Length: 8 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: System Setup: Add Defaults Tab

e The Compulink University course 'System Setup: Add Defaults Tab’ was added.

¢ It can be found under the following Program: Practice Admin

e Course Description: Learn where to set Default values for new patient accounts to inherit
when added to the software.

e Published: 1/24/23 - Length: 3 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: System Setup: Deductible Sieve Tab

e The Compulink University course 'System Setup: Deductible Sieve Tab’ was added.

¢ It can be found under the following Program: Practice Admin

e Course Description: Learn about the Deductible Sieve parameters that may be used to
put claims on hold if a patient’s unmet deductible falls below a specific threshold amount.

e Published: 1/24/23 - Length: 3 Minutes

(1/31/2023)(12.6.0.16) Video > NEW: System Setup: Miscellaneous Tab
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Education

e The Compulink University course 'System Setup: Miscellaneous Tab’ was added.

e It can be found under the following Program: Practice Admin

e Course Description: Learn about the number of parameters you can utilize to customize
data entry and assign security control to different areas of your patient records, including
appointments, ledgers, recall, inventory and more.

e Published: 1/24/23 - Length: 20 Minutes

(1/12/2023)(12.6.0.16) Video > NEW: Appointment Scheduling Table Setup

e The Compulink University course 'Appointment Scheduling Table Setup' was added.

e It can be found under the following Program: Appointments

e Course Description: The following appointment setup tables are reviewed in this course:
Categories, Reasons and Status.

e Published: 1/10/23 - Length: 13 Minutes

(1/12/2023)(12.6.0.16) Video > NEW: DMA Tools III

e The Compulink University course 'DMA Tools III' was added.

¢ It can be found under the following Program: Word Processing

e Course Description: This is part three of three of the DMA Tools Functions series. This
course covers Recordselect, Filter and Sort Order.

e Published: 1/10/23 - Length: 7 Minutes

(1/12/2023)(12.6.0.16) Video > NEW: SMART Workflow Setup

e The Compulink University course 'SMART Workflow Setup’ was added.

¢ It can be found under the following Program: Patient Flow

e Course Description: Learn how to track patients through your office utilizing SMART
Workflow.

e Published: 1/10/23 - Length: 16 Minutes

(1/12/2023)(12.6.0.16) Video > UPDATED: Accounting Interface

e The Compulink University course 'Accounting Interface' was updated.

e It can be found under the following Program: Practice Admin

e Course Description: Review the available options for interfacing your 3rd party accounting
software with Advantage and walk through an overview of the setup process.

e Republished: 1/10/23 - Length: 11 Minutes

Appointment

Appointment > Commands

(11/9/2022)(12.6.0.16) Wait List > View Waiting List > Print

¢ The following changes were made to the Crystal Report that prints:
e Column headers are underlined.
e ADDED column - This is a NEW column to display the date the Appointment was
added to the Wait List. (Request)
e COMMENTS/PHONE column - If the Comments are empty, the ‘Comments’ label
no longer displays.

Communication

(9/20/2022)(12.6.0.16) Message Upon Launch > Console and FileLog FLG Files

e The Compulink Support staff may set up one of the following files in your product Log
folder when helping to troubleshoot an issue:
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Communication

e Console.FLG
e FileLog.FLG
o If one or both of these files are present when the user launches the software, the
following message will display:
Complete Product Tracing has been ENABLED due to
Existence of either FileLog.FLG or Console.FLG found in
the LOG Sub-folder beneath product Folder which will
have an impact on System Performance!
e Contact your administrator to rename or remove the files.

(9/20/2022)(12.6.0.16) Message Upon Launch > NonProductionServer FLG File

e Update for clients that are running a test server.

o If the file NonProductionServer.FLG is found in the Advantage product folder, the following
message will display upon launch:
WARNING! Non-Production Server!

Customization

(11/7/2022)(12.6.0.16) Screen Builder > ALL > DateTimePicker

e The object DateTimePicker was updated.
e This field now allows for free-texting the date format as well as giving a drop-down to
select from the calendar.

(9/29/2022)(12.6.0.16) Smart Function Editor > Exam > NEW Smart Function

e The following NEW Smart Function was added: SubTableUniqueRecordFieldForward
e Purpose:

¢ Designate which fields from an Exam Sub-Table record forward to the new record.
(Request)
e Description:

e Forwards only the specified fields from the highlighted record to the new record.
e Function Code:
SF.SubTableUniqueRecordFieldForward(ReqgTable:String;ReqUnique:Integer;Fieldarray:array
of String);
¢ Definitions

e RegTable:String - Name of the table to look at

e ReqUnique:Integer — Unique identifier for record

e Fieldarray:array of String - List of fields to forward
e Example: Forward Diagnosis without Assessments and Plans
Begin
SF.SubTableUniqueRecordFieldForward('ExamDiag',Sf.GetFieldInteger('ExamDiag','DiagUniq
ue'),['PatUnique’,'Code’,'Desc’,
'ProblemSeveritySTDC','ClaimUse','ConditionVerificationStatSTDC','ConditionCategorySTDC'

1)
End;

Exam

Exam > General & Display Changes

(9/29/2022)(12.6.0.16) Data Entry > Forward from Last Visit

¢ Right click on a tab or in a field to display the option Forward from Last Visit.
e This will find the last visit with the matching EpisodeUnique number and forward the
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Exam > General & Display Changes

information into the new tab/field. (Request)

(9/29/2022)(12.6.0.16) Data Entry > Health History Relationship

Fields with SNOMED in the name connect to a table of Codes, used for data exchange
within your Advantage software and externally.
e The field value in the table is a number that 'looks up' the corresponding text value in the
SNOMED table.
e Example: The data field for Health History Relationship is SNOMEDRELATIONSHIP.
e A SNOMEDRELATIONSHIP value of '90691' displays 'Daughter’ in the Health
History screen.
* You now have access to change the Display Order and Hide entries in the Health History
Relationship drop-down table.
e Right click in the field and select View Lookup List Entries to open the table with
the list of entries.
¢ Use the Edit command to Edit the entry and change the Display Order or change
Hide to Y to prevent it from displaying in the drop-down.
e You may also use the Hide command to quickly go through and Hide multiple
entries.
e Making a change adds a record to the internal table SNOMEDCONTROL.

(11/7/2022)(12.6.0.16) Data Entry > Standard Code Fields

¢ Fields with STDC in the name connect to a table of Standard Codes, used for data
exchange within your Advantage software and externally.
¢ The field value in the table is a number that 'looks up' the corresponding text value in the
standard codes table.
e Example: The data field for Place of Service or POS is POSSTDC.
e A POSSTDC value of '5463' displays 'Office' in the Patient Exam screen.
¢ You now have access to change the Display Order and Hide entries in the Place of
Service/POS and Visit Type drop-down tables. (Request)
e Editing the table:
e Right click in the field and select View Lookup List Entries to open the table with
the list of entries.
¢ Use the Edit command to Edit the entry and change the Display Order or change
Hide to Y to prevent it from displaying in the drop-down.
e You may also use the Hide command to quickly go through and Hide multiple
entries.
e Making a change adds a record to the internal table STANDARDCODECONTROL.
e NOTE: When you make a change, the Owner field changes to U.
¢ This indicates that you have made a change to this table for this record.
e The default information remains in the Static table as Compulink-owned.
¢ This allows us to continue to update records as needed, and not interfere
with your changes.

(11/7/2022)(12.6.0.16) Data Entry > Upon Exit Smart Functions

e Smart Functions connected to fields to run upon exit of the field have been updated.
e This has been done for fields attached to TCBSDBComboBox and TCBSDBEdit objects.
o If the user selects information and does not exit the field, it will now automatically run
the Smart Function upon saving the record. (Request)
e Example:
e Smart Function tells the software to add the data in the Edit box to the memo field
to create a narrative.
¢ You select the data in the Edit box, but you don't exit the field by clicking in
another field or tabbing out.
¢ You go directly to the Save icon to save the record.
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e The software now looks at that field and runs the Smart Function prior to saving.

Exam > Commands

(9/20/2022)(12.6.0.16) Print > Audit Report > Sub-Table Edits

o All edits to Exam sub-table records will now display on the Audit report.
* Previous versions only displayed the edits if they were done after the record was signed
off on.

Exam > Layouts & Tabs

(1/4/2023)(12.6.0.16) Tab(s) > ADDED: Care Plan

e Tab Name: Care Plan
e Tab Label: Care Plan

e Created to document the patient’s Care Plan.
¢ Contains the following panel for documentation/review:
¢ Details

(1/4/2023)(12.6.0.16) Tab(s) > ADDED: Care Plan (HiRes)

e Tab Name: Care Plan (HiRes)
e Tab Label: Care Plan

e Created to document the patient’s Care Plan.
* Contains the following panel for documentation/review:
¢ Details

(4/17/2023)(12.6.0.16) Tab(s) > ADDED: PopUpCarePlan

e Tab Name: PopUpCarePlan
e Tab Label: Care Plan

e Created to document the patient’s Care Plan.

e Care Plan panel
e Category field
e Category of the Care Plan. Example: Cataract SurgicalCare, Knee
Replacement Care, etc.
¢ Select from the drop-down.
¢ Right click in the field and select View Lookup List Entries to modify the
CAREPLANCATEGORY table.

e Date
e Date Care Plan last updated.
e This is a virtual field that displays on the screen, but is not found in the
database.

¢ Details field
e Description of the Care Plan. This can be multiple items. Example: Order
implant, Schedule Surgical Pre Op.

e Episode Name field
¢ Used with Advantage products containing Episode of Care.
e Connect the patient’s Episode of Care to the Care Plan.
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e Intent field
e Intent of the Care Plan. Example: Order, Proposal, etc.
e Select from the drop-down.
¢ Right click in the field and select View Lookup List Entries to modify the
CAREPLANINTENT table.

e Name field
¢ Name of the Care Plan. Example: Post-Surgical Care Plan.
¢ Select from the drop-down.
o If a Category is assigned in the table, that field is automatically
populated.

e Start
e Date Care Plan record added; pulls from the Exam date.
¢ This is a virtual field that displays on the screen, but is not found in the
database.

e Status field
e Status of the Care Plan. Example: Active, Completed, etc.
e Select from the drop-down.
¢ Right click in the field and select View Lookup List Entries to modify the
CAREPLANSTATUS table.

e Updates panel
¢ Displays the updates made to the Care Plan.
e Each time the Care Plan is edited, it creates a “child” record that displays in the
grid.

e Grid details:
e Updated - Date Care Plan was updated
e Status - Status documented at time of update
¢ Intent - Intent documented at time of update
e Details — Update details about the Care Plan

(12/2/2022)(12.6.0.16) Tab(s) > DISCONTINUED: Lab Tests (Tablet)

e Tab Name: Lab Tests (Tablet)
e Tab Label: Lab Test

¢ This tab was discontinued as it is no longer supported by Compulink.

(11/30/2022)(12.6.0.16) Tab(s) > EDITED: Lab Tests

e Tab Name: Lab Tests
e Tab Label: Lab Test

e Actions panel
¢ Procedure Status
e Added for 21st Century Cures.
e New label added to display new field.
e Report Status
¢ Added for 21st Century Cures.
e New label added to display new field.

(11/8/2022)(12.6.0.16) Tab(s) > EDITED: PopUpDocumentsImages

e Tab Name: PopUpDocumentsImages
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e Tab Label: Doc/Img

e Document Category field
e Added for 21st Century Cures.
e NEW field to document the Category of the Document. Example Consultation note,
Privacy policy, etc.
e Select from the drop-down.

e Document Type field
e Added for 21st Century Cures.
e NEW field to document the Type of the Document. Example: 3D printed model,
Consultation note, etc.
¢ Select from the drop-down.

¢ Status field
e Added for 21st Century Cures.
e NEW field to document the Status of the Document. Example: Current,
Superseded, etc.
e Defaults to Current.
e Select from the drop-down.

(2/27/2023)(12.6.0.16) Tab(s) > EDITED: PopUpGoals

e Tab Name: PopUpGoals
e Tab Label: Goals

¢ Achieved field
¢ A Smart Function was added to the label.
e When clicked, the following actions will occur:
e The current date populates the Achieved field.
e The Status field is updated to ‘Completed”.

e D/C'd field
e A Smart Function was added to the label.
e When clicked, the following actions will occur:
e The current date populates the D/C'd field.
e The Status field is updated to ‘Canceled".

e Status field
e Added for 21st Century Cures.
e NEW field to document the Life Cycle Status of the Goal. Example: Active, On
Hold, etc.
e Defaults to ‘Active’.
e Select from the drop-down.

(12/3/2022)(12.6.0.16) Tab(s) > EDITED: PopUpISSPDiag

e Tab Name: PopUpISSPDiag
e Tab Label: PopUpDiagl

e Abatement field
e Added for 21st Century Cures.
o NEW field to document the Abatement/Alleviation date of the Condition. Character
field allows for selection of a date, or entry of a non-date answer. Example: 1
month.
e Select from the drop-down.
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¢ Condition Category field
e Added for 21st Century Cures.
e NEW field to document the Category of the Condition. Example: Problem List Item
or Encounter Diagnosis.
¢ Select from the drop-down.

* Condition Status field
e Added for 21st Century Cures.
e NEW field to document the Condition/Diagnosis Status. Example: Active, Relapse,
etc.
e Defaults to ‘Active’.
e Select from the drop-down.

¢ Onset field
e Added for 21st Century Cures.
e NEW field to document the Onset date of the Condition. Character field allows for
selection of a date, or entry of a non-date answer. Example: 1 month.
¢ Select from the drop-down.

» Verification Status field
e Added for 21st Century Cures.
e NEW field to document the Verification Status of the Condition. Example:
Unconfirmed, Provisional, etc.
e Select from the drop-down.

(12/3/2022)(12.6.0.16) Tab(s) > EDITED: PopUpISSPGoals

e Tab Name: PopUpISSPGoals
e Tab Label: PopUPISSPG

¢ Achieved field
¢ A Smart Function was added to the label.
e When clicked, the following actions will occur:
e The current date populates the Achieved field.
e The Status field is updated to ‘Completed”.

e D/C'd field
¢ A Smart Function was added to the label.
e When clicked, the following actions will occur:
e The current date populates the D/C'd field.
¢ The Status field is updated to ‘Canceled’.

e Status field
e Added for 21st Century Cures.
e NEW field to document the Life Cycle Status of the Goal. Example: Active, On
Hold, etc.
e Defaults to ‘Active’.
¢ Select from the drop-down.

(11/28/2022)(12.6.0.16) Tab(s) > EDITED: PopUpImmunization

e Tab Name: PopUpImmunization
e Tab Label: Immunize

e Date field
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Exam > Layouts & Tabs

e This field was removed, as it defaults to the Exam date as Added Date.
e The Ordered and Performed date fields should be used for documentation.

e Performed label
e A Smart Function was added to the label.
e When clicked, the following fields are populated:
¢ Performed populates with the Exam date.
e Status populates with Completed.

¢ Reason field (Status)
e Added for 21st Century Cures.
e NEW field to document the Reason for the Status selected.
¢ Select from the drop-down.

o Status field
e Added for 21st Century Cures.
e NEW field to document the Status of the Immunization.
e Select from the drop-down.

(1/4/2023)(12.6.0.16) Tab(s) > EDITED: PopUpImplantDevice

e Tab Name: PopUpImplantDevice
e Tab Label: Device

* Type field
e Added for 21st Century Cures.
e NEW field to document the Type of Implantable Device.

(12/19/2022)(12.6.0.16) Tab(s) > EDITED: PopUpIndServicePlan

e Tab Name: PopUpIndServicePlan
e Tab Label: PopUpIndSe

¢ Notes panel
e Notes label
e A Smart Function was attached; when clicked, it clears the field.

(12/19/2022)(12.6.0.16) Tab(s) > EDITED: PopUpPrint

e Tab Name: PopUpPrint
e Tab Label: Print

e Accessed from the following tabs:
e HiResSessNoteMH
¢ HiResSessNotePsych
e PlanMH
e Therapy

e Full Summary icon
e Smart Function attached updated to print document ‘ExamComplete’.

(12/13/2022)(12.6.0.16) Tab(s) > EDITED: PopUpTest

e Tab Name: PopUpTest
e Tab Label: Test

e Actions panel
e Canceled field
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e Added for 21st Century Cures.
e NEW field to document the date the Test was canceled if not performed.

e Canceled label
e A Smart Function was added to the label.
e When clicked, the following fields are populated:
e Canceled populates with the Exam date.
¢ Proc Status populates with Not Done.

e Cx Note field
e Added for 21st Century Cures.
e NEW field to document the reason for canceling the Test.

¢ Performed label
e A Smart Function was added to the label.
* When clicked, the following fields are populated:
e Performed populates with the Exam date.
e By populates with the ID of the person logged into the software.
e Status populates with Completed.

e Performed wrench icon
e This was removed with the addition of the Smart Function attached to the
label that performs the same functionality.

e Procedure Status field
¢ Added for 21st Century Cures.
e NEW field to document the Status of the Test.
e Defaults to In Progress.
e Updates to Completed upon entering of the Performed date.
e Select from the drop-down.

e Report Status field
e Added for 21st Century Cures.
¢ This is a NEW field to document the Status of the Report.
e Updates to Final upon entering of the Reviewed date.
e Select from the drop-down.

e Reviewed label
e A Smart Function was added to the label.
e When clicked, the following fields are populated:
e Reviewed populates with the Exam date.
e By populates with the ID of the person logged into the software.
e Report Status populates with Final.

e Reviewed wrench icon
e This was removed with the addition of the Smart Function attached to the
label that performs the same functionality.

(12/19/2022)(12.6.0.16) Tab(s) > EDITED: PopUpTherapy

e Tab Name: PopUpTherapy
e Tab Label: Therapy

e Top Header
e Ellipsis Hover Menu
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e Encounter Favorites — This is a NEW option added to select a pre-defined
Encounter Favorite to populate the tab.

¢ Notes panel
¢ Notes label
e A Smart Function was attached; when clicked, it clears the field.

(2/27/2023)(12.6.0.16) Tab(s) > EDITED: PopUpVitals

e Tab Name: PopUpVitals
e Tab Label: Vitals

e BMI Percentile field
e Added for 21st Century Cures.
e NEW field to document the relative position of the patient’s BMI among people of
the same sex and age. For pediatric care.

¢ Head Circ field
e Added for 21st Century Cures.
e NEW field to document the circumference of the patient’s head.
e This is needed to calculate the head circumference percentile. For pediatric care.

¢ Head Circ Percentile field
e Added for 21st Century Cures.
e NEW field to document the relative position of the patient’s head circumference
among people of the same sex and age. For pediatric care.

o Weight Percentile field
e Added for 21st Century Cures.
e NEW field to document the relative position of the patient’s weight among people
of the same sex and age. For pediatric care.

(12/19/2022)(12.6.0.16) Tab(s) > EDITED: See Below

e The change below was made to all tabs with the Medications panel.

e The default filter on the grid is ‘Current Meds’ to only show medications that do not have
a Stop date. (Request)
e Highlight the ellipsis, highlight ‘Filter’ and select to view one of the following:
e Erx Meds
¢ All Medications

(12/19/2022)(12.6.0.16) Tab(s) > EDITED: Summary

e Tab Name: Summary
e Tab Label: Summary

o Left panel
e Psych Initial Narrative icon
e Smart Function attached updated to print document ‘ExamComplete’.

Exam > Look-up Tables

(1/11/2023)(12.6.0.16) Look-up Tables > Diagnosis > Name > EDITED: See
Below

* Table edited and the following fields were added:
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e Category
e This is a NEW field to enter the Category of the Condition.
e Example: Problem List Item or Encounter Diagnosis.

o \erification Status
e This is a NEW field to enter the Verification Status of the Condition.
e Example: Unconfirmed, Provisional, etc.

This field was added for future certification and is currently in development.
e Location

(1/13/2023)(12.6.0.16) Look-up Tables > Image > Category > EDITED: See
Below

e This table was updated due to 21st Century Cures requirements.

e Display Order
e Used to control the position of items in drop-down lists.
e Enter a number between 1 and 999998. Default is 999999 to display in the order
added to the table.

¢ Hide
e A'Y' Hides the item from display in drop-down lists.

¢ Interoperability Name
¢ Logical Observation Identifiers Names and Codes - identifier for this Image
Category used by HL7 messages.

e Local Name
e Name for Image Category that displays in the drop-down.

¢ Modified
e Date this record was last modified; system generated and not editable.

e Owner
e Each entry has an assigned Owner, 'U' for User or 'C' for Compulink.
¢ This allows Compulink to update our records without stepping on those you
create.
e Owner 'C' records are not modifiable, but you can Hide them from Display.

(11/30/2022)(12.6.0.16) Look-up Tables > Image > Option > ADDED: See Below

e This is a new table added due to 21st Century Cures requirements.

e Data moved from the existing entries in the LookUp.adt table to create new table.

e Accessed by right clicking in the Description field on the PopUpDocumentsImages tab and
selecting View Lookup List Entries.

e Display Order
e Used to control the position of items in drop-down lists.
e Enter a number between 1 and 999998. Default is 999999 to display in the order
added to the table.

¢ Hide
e A 'Y' Hides the item from display in drop-down lists.

o Interoperability Name
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¢ Logical Observation Identifiers Names and Codes - identifier for this Image
Option/Description used by HL7 messages.

¢ Modified
e Date this record was last modified; system generated and not editable.

e Name
e Name of Image Option/Description. Example: History and Physical.

e Owner
e Each entry has an assigned Owner, 'U' for User or 'C' for Compulink.
¢ This allows Compulink to update our records without stepping on those you
create.
e Owner 'C' records are not modifiable, but you can Hide them from Display.

Exam > Orders

(9/20/2022)(12.6.0.16) Orders > Order Details > Display Order

e When an Order is selected, the Order Details display based upon the Display Order
assigned in the table.

(9/20/2022)(12.6.0.16) Orders > Order Sets > No Duplicates

¢ Clicking on the Order Set underlined label opens the Select Order Sets window to allow
you to select more Sets to add to the record.

o If you happen to select one that already exists in the SMART Patient Orders list, the
window closes and the existing Order Set is checked.

e This prevents the user from adding duplicate Order Sets in the SMART Patient Orders
window.

(11/7/2022)(12.6.0.16) Orders > Order Sets > Rebuilds

o If an Order Detail connected to the Order Set is deleted from it’s table, the software
automatically rebuilds the Order Set table to remove it from there as well.
¢ Order Detail tables that functionality was added for:
e Education
e Medication
e Orders
e Surgery
o Test
e Treatment
e Example:
e Order Set ‘Inflammation’ has the Treatment ‘Ice Pack’ connected to it.
e The user goes into the Treatment Name table and deletes the ‘Ice Pack’ record.
e The software rebuilds the Order Set table and removes ‘Ice Pack’ from Order Set
‘Inflammation’.

Exam > Utility

(11/7/2022)(12.6.0.16) Utility > Location/Staff Filtering > Layouts or Tabs >

Discontinued Column

e A '‘Discontinued’ column was added to both the Layouts and Tabs tables.

¢ If the item has been discontinued in Screen Builder, that date displays in the tables to
help prevent staff from making changes to items that are no longer being used by the
practice.
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Function

Function > Inventory

(1/6/2023)(12.6.0.16) Inventory > Audit > New Reports

* New and updated reports based upon the output selected are now available. (Request)

¢ Select the output of Itemized List or Summary Only, run the audit and then click Print.

* The following new message appears: Would you like to see an Audit Log of all of the
items scanned?

e Qutput Itemized List:
e Select '‘No’ to the Audit Log.
e This is the same as the legacy Itemized List output.
¢ Contains the following:
¢ Itemized Audit Log
¢ INVENTORY DISCREPANCY SUMMARY

e Output Itemized List:
e Select ‘Yes' to the Audit Log.
¢ Contains the following:
e Itemized Audit Log
¢ INVENTORY DISCREPANCY SUMMARY
¢ AUDIT LOG SUMMARY
e Location(s)
¢ Unique Items Scanned
e Total Items Scanned
¢ Cost Total
¢ Retail Total

e Qutput Summary Only:
e Select '‘No’ to the Audit Log.
e This is the same as the legacy Summary Only output.
e Contains the following:
e INVENTORY DISCREPANCY SUMMARY

e Qutput Summary Only:
e Select ‘Yes’ to the Audit Log.
¢ Contains the following:
e INVENTORY DISCREPANCY SUMMARY
e AUDIT LOG SUMMARY (see above)

(9/20/2022)(12.6.0.16) Inventory > Receive Transfers > New Report

e The output of Itemized List now produces the INVENTORY BATCH RECEIVE REPORT in the
Report Viewer when the operation is complete.
e Report:
e Header
¢ LOCATION FROM - Location Code of the practice where the Inventory item
was transferred from.
e RECEIVED AT LOCATION - Location Code of the practice the Inventory item
was transferred to (received at).
e (0,Z) TYPE - Type of Inventory that was received. Example: FRAMES.
e Detail Display
e STOCK # - Stock# of the item received
e MANUFACTURER - Manufacturer assigned to the item in the receiving
Location’s Inventory.
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e NAME - Name assigned to the item in the receiving Location’s Inventory.

¢ CATEGORY - Category assigned to the item in the receiving Location’s
Inventory. Example: Unisex.

e COST - Cost of the item in the originating Location’s Inventory.

e RETAIL - Retail of the item in the originating Location’s Inventory.

e QTY - Quantity of the item received.

Ledger

Ledger > Charge Window

(9/29/2022)(12.6.0.16) Charge Window > Payor Notes > Follow Up Date

e When adding/editing a Payor Note, you are now able to select the current date for the
Follow Up date. (Request)

Ledger > Commands

(3/23/2023)(12.6.0.16) Credit > Responsible (Any Option) > Credit Card
Payment

¢ If the amount of payment submitted to the Credit Card vendor doesn’t match the
approved amount, the following Warning displays: Approval was for Patient Amount of
$XX. XX
e Example:
¢ Credit > Responsible $13.00
e Apply to charges
e Select the Credit Card payment in the Transaction window.
e Request is sent to vendor, but vendor only approves $5.32
e Warning message: Approval was for Patient Amount of $5.32
¢ Click OK and the payment line saves with the Credit amount of $5.32

(9/20/2022)(12.6.0.16) Credit > Responsible (Any Option) > Tender Type

o After posting a Credit and selecting the Tender Type, if the Type selected is not connected
to a Payment Type in the table, a second window will open for you to Select Tender Type
Category.

¢ Upon saving, the software will assign the Category chosen to the Tender Type in the table.
Utility > Look-up Tables > Financial > Tender Types.

(11/7/2022)(12.6.0.16) Options > Create Unapplied Payment > Option Renamed

e The option ‘Delete Line Item Pmt Dist” was renamed to ‘Create Unapplied Payment’ to
better describe what the process is creating.

(1/4/2023)(12.6.0.16) Print > Statement > 2 Line Messagge

¢ A new Statement named LedgerStatement_MsgSplit was added.
¢ If you have 2 lines of Statement Message, it merges on 2 distinct lines. (Request)
e The current Statement merges both lines together as if one sentence.
e This works well for offices that have one long sentence, but have to use both lines
to enter the information.

e The file is delivered as LedgerStatement_MsgSplit.LedgerScrnRpt.

o If you would like to use this Statement, you must rename your existing file, then rename
this one to the file that is automatically selected when printing from the Ledger and in the
batch function.

e Have your Administrator go into the Advantage product folder.
e Find the file: LedgerStatement.LedgerScrnRpt

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .

elearning@compulinkadvantage.com | www.compulinkadvantage.com



Ledger > Commands

e Rename this file to LedgerStatement.LedgerScrnRptOrig
e Find the file: LedgerStatement_MsgSplit.LedgerScrnRpt
e Rename this file to LedgerStatement.LedgerScrnRpt

e Statement Messages:
e Standard Statement Messages are assigned in the System Setup Acct. Billing tab.
e Alternate messages are set up in the Billing Messages table.
e You may also free-type a message when printing a Statement from the Ledger.

¢ Using the vertical pipe character:
e Using the vertical pipe ( | ) on your keyboard, forces a line break in the message.
e Double vertical pipes (||) must be entered either at the end of the first line or the
beginning of the second line to create the break.
e These must be entered in both the System Setup and the Billing Messages table.
¢ Line one of message. ||
¢ Line two of message.
¢ If you free-type a message at the time of printing a Statement from the Ledger,
you must type the vertical pipes with your message.
¢ Free-type line one.||
e Free-type line two.

Look-up Tables

Look-up Tables > EHR

(11/8/2022)(12.6.0.16) EHR > Diagnosis > Name > 21st Century Cures Act
Changes

¢ The following changes were introduced for 21st Century Cures Act documentation:
e Category
e This is a NEW field to define the Category of the Diagnosis/Condition.
e Example: Problem List Item or Encounter Diagnosis.
e Some records are populated by Compulink during the version update.

» Verification Status
e This is a NEW field to define the Verification Status.
e Example: Confirmed, Unconfirmed, Provisional, etc.
e Some records are populated by Compulink during the version update.

(1/4/2023)(12.6.0.16) EHR > Surgery > Name > Order Set Name

e The ‘Order Set Name’ field may now be edited on Compulink-Owned records. (Request)

(9/7/2022)(12.6.0.16) EHR > Test > Name > 21st Century Cures Act Changes

¢ The following changes were introduced for 21st Century Cures Act documentation:
¢ LOINC Description

e This is an existing field that is now populated by Compulink.

e Some records are populated by Compulink during the version update.

e Users may edit their user-owned records and pull in a matching Description.

* Diagnostic Report Category
e This is a NEW field to categorize the type of Test.
e Example: Name=Blood Test and Diagnostic Report Category=Hematology
e Some records are populated by Compulink during the version update.
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Look-up Tables > Financial

(2/9/2023)(12.6.0.16) Financial > Fees > Services > 76998

e Intraoperative Guidance (76998) was added to the table for new installs.
» Existing clients need to add it to the Services table if they will be posting it to the Ledger.
e Post Code: 76998
e Name: Intraoperative Guidance
e UNIT: 1
¢ Place of Service: Ambulatory Surgical Center
e Type of Service: Surgery
e Category: Surgery

(12/13/2022)(12.6.0.16) Financial > Payors > Names > ERA

o If the field ERA Available = 'N’, the software does not allow the field ERA Auto Posting to
be set to Y’. (Request)

(12/13/2022)(12.6.0.16) Financial > Tender Types > ADDED: CC Manual

¢ If the type doesn't already exist in the table, upon update the type ‘CC Manual’ is added.
e Description = CC Manual
e Code =C
e Payment Type = Credit Card
e This should be used when posting a manual Credit Card payment, and not using an
interface.

Look-up Tables > General

(9/20/2022)(12.6.0.16) General > Location > Details > ADDED: See Below
e End

e This is a NEW field added for 21st Century Cures Act Organization FHIR Messages.
e If a Location is no longer going to be utilized, enter the End date.

e Start
e This is a NEW field added for 21st Century Cures Act Organization FHIR Messages.
o If a Location is going to be utilized after a certain date, enter the Start date.

(11/7/2022)(12.6.0.16) General > Provider > ADDED: See Below

e Automatic EPA
e This is a NEW field allows the Provider to choose if they want to utilize Electronic
Prior Authorization when ePrescribing medications. (Request)
e Default is ‘N’ or False.
e Automatic Formulary may still be set to 'Y’ if they choose.

Patient

Patient > General & Display Changes

(1/11/2023)(12.6.0.16) Display Change(s) > Location Field
e The Location field in the top left was updated to the NEW rounded GUI.

(9/29/2022)(12.6.0.16) General Change(s) > Data Entry > Standard Code Fields

¢ Fields with STDC in the name connect to a table of Standard Codes, used for data
exchange within your Advantage software and externally.

¢ The field value in the table is a number that 'looks up' the corresponding text value in the
standard codes table.
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Patient > General & Display Changes

e Example: The data field for primary language in the Patient table is LANGSTDC.
e A LANGSTDC value of '5150' displays 'English' in the Patient Demographic screen
and '10258' displays 'Mandarin'.
¢ You now have access to change the Display Order and Hide entries in drop-down tables
connected to these Standard Code fields. (Request)
¢ Right click in the field to open the table with the list of entries.
¢ Use the Edit command to Edit the entry and change the Display Order or change
Hide to Y to prevent it from displaying in the drop-down.
e You may also use the Hide command to quickly go through and Hide multiple
entries.
e Making a change adds a record to the internal table STANDARDCODECONTROL.
¢ See the following topic in the Advantage Online Help Manual for details on which fields are
STDC fields: Data Dictionary > Patient Demographics.

Patient > Commands

(1/11/2023)(12.6.0.16) Insurance > Name Field Search

e You may now enter the Payor ID in the Name field and then click the drop-down arrow to
only display Payors with a matching ID in the table.

Patient > Insurance

(1/11/2023)(12.6.0.16) Insurance > Name Field Search

e You may now enter the Payor ID in the Name field and then click the drop-down arrow to
only display Payors with a matching ID in the table.

Patient > Layouts & Tabs

(11/28/2022)(12.6.0.16) Tab(s) > EDITED: PopUpAddHx

o First field
e Added for 21st Century Cures.
e NEW field to document the patient’s First Name (if changed).

e Last field
e Added for 21st Century Cures.
e NEW field to document the patient’s Last Name (if changed).

¢ Middle field
e Added for 21st Century Cures.
e NEW field to document the patient’s Middle Name (if changed).

o Suffix field
e Added for 21st Century Cures.
e NEW field to document the patient’s Suffix (if changed).

Reports

Reports > Appointment

(11/9/2022)(12.6.0.16) Appointment > Analysis > EDITED: Statistics

¢ Report changes:
e The following Summaries are now included: (Request)
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Reports > Appointment

e APPOINTMENT STATUS SUMMARY BY DEPARTMENT
e APPOINTMENT REASON SUMMARY BY DEPARTMENT
e APPOINTMENT STATISTICS DETAIL
e A '‘Dept’ column was added.
e The ‘Patient’ column now displays the name of the patient at the time the
report is run, not at the time the Appointment was made.
e If the patient changes their name between the time the Appointment

is made and the report is run, and the Demographics are updated,
that new name displays on the report.

(11/9/2022)(12.6.0.16) Appointment > Daily > EDITED: Missing Charges

e Parameter/Option changes:
e Appointment Status (one or more)
e Updated with the option to run the report for one or more Status values.
(Request)
¢ Options for Parameter entry:
eL,K, B
o LK,B
e LKB
e Match Code 9nnnn?
e This is a NEW Parameter/Option added.
¢ Option to only show Appointments where a code starting with 9 was not
posted to the Ledger. (Request)
e Default is ‘False’ to display Appointments that had no charges at all posted
to the Ledger.
e Set to 'True' to only display Appointments that did not have a code starting
with 9 posted to the Ledger.
e Can be used with pertinent Appointment Reason for targeted filtering.
e Example: Appointment Reason="New Patient’ and Match Code
9nnnn?="True’.
e Only the following Appointments will display on the report: Reason of
‘New Patient’ and NO charge with a code starting with 9 posted to
the Ledger.

(11/9/2022)(12.6.0.16) Appointment > Daily > EDITED: No Future Appt

e Report changes:
e The NEW column '‘EHR#’ was added to display the patient’s unique identifier.
(Request)

Reports > Electronic Health Record

(9/20/2022)(12.6.0.16) Electronic Health Record > EDITED: MACRA Readiness

¢ In 2022, practices might not be required to fill out any questionnaire on the percentage of
patients in EHR with billing to Medicare, Medicaid or other breakdowns on this report.

 However, the Medicare, Medicaid, Medi-Medi and demographic counts in this report were
part of the MACRA Readiness Review in the past, and might still be of interest to your
office.

Reports > Financial

(1/6/2023)(12.6.0.16) Financial > Acct Management > EDITED: --BETA A-R
Responsible

e Report changes:
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Reports > Financial

e The following message was added to the top of the report:
Thanks for client input on the BETA A/R reports. We used that to improve A/R reporting.
We will soon retire the BETA A/R Reports. Please use these A/R reports.
Report > Financial > Acct Management > Accounts Receivable
Report > Financial > Acct Management > Accts Receivable by Service Loc
You can use online Help topics and classes to learn more about the A/R reports.

(1/6/2023)(12.6.0.16) Financial > Acct Management > EDITED: --BETA A-R by
Account

e Report changes:
e The following message was added to the top of the report:
Thanks for client input on the BETA A/R reports. We used that to improve A/R reporting.
We will soon retire the BETA A/R Reports. Please use these A/R reports.
Report > Financial > Acct Management > Accounts Receivable
Report > Financial > Acct Management > Accts Receivable by Service Loc
You can use online Help topics and classes to learn more about the A/R reports.

(9/20/2022)(12.6.0.16) Financial > Analysis > EDITED: RVU Analysis with
Modifiers

e The documentation on the report was updated to better explain the calculations.
e This can be found on the last page of the report:
¢ Definitions
e RVU: (Units) x (WorkRVU) x (CF). Units on the charge are multiplied by the
WorkRVU and CF field values in the RVU table for the CPT on the charge.
In Advantage Version 12.5, CF was referenced. In Version 12.6+ the CF
and WorkRVU values are both referenced in calculations.

(12/2/2022)(12.6.0.16) Financial > Daily > EDITED: Payment

e Parameter/Option changes:
e Unapplied Use Add Loc?
e Option to report Unapplied payments on the Location code that they were
added, and not just under the wildcard (...).
e Default of ‘False’ displays no change in the report output.
e Set to ‘True’ to display the Unapplied payment under the Location Code that
the payment was added at.

Reports > System Admin.

(9/7/2022)(12.6.0.16) System Admin. > EDITED: Extended Audit Report

e Parameter/Option changes:
e Date/Time (D)esc (A)scending
¢ This option was added for 21st Century Cures compliancy.
e Visit the HealthIT.gov website for details:
https://www.healthit.gov/test-method/audit-reports-cures
e Option to display the data entries under the sorted areas by Date/Time in
Ascending or Descending order. (Request)
e Default is ‘D’ for Descending.
e Example:
e SORT = A
e Date/Time (D)esc (A)scending = D
e Output is sorted by the Area; below the Area, each entry is sorted
in Descending order by Date/Time.

e Report changes:
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Reports > System Admin.

e Header
e The Group/Sort was updated to include either Ascending or Descending.
e Detail Display
e The detail items will now display in either Ascending or Descending order
based upon the user’s selection.

(9/7/2022)(12.6.0.16) System Admin. > EDITED: PHI Audit Event Log

e Parameter/Option changes:
e Date/Time (D)esc (A)scending
¢ This option was added for 21st Century Cures compliancy.
¢ Visit the HealthIT.gov website for details:
https://www.healthit.gov/test-method/audit-reports-cures
¢ Option to display the data entries under the sorted areas by Date/Time in
Ascending or Descending order. (Request)
e Default is ‘D’ for Descending.
e Example:
e Sort By Action Taken = True
e Date/Time (D)esc (A)scending = A
e Output is sorted by the Action; below the Action, each entry is sorted
in Ascending order by Date/Time.

e Report changes:
e Header
e The Sort Detail was added to display either Ascending or Descending.
e Sort/Detail Display
e The Reports Selected (all of them) display in the Header.
e Example: Reports Selected | User ID | Action Taken | Descending
¢ A new page will display for the start of each Sort option selected.
e Example:
e Page 1: PHI Audit Event Log by Staff ID
e Page 5: PHI Audit Event Log by Action Taken
¢ The detail items will now display in either Ascending or Descending order
based upon the user’s selection.

Utility

(3/9/2023)(12.6.0.16) Diagnostics > Diags in Use Message

o If running Advantage Database Server version 12, a new online re-indexing is available.

¢ This allows index only diagnostics to run with users in the software.

e When entering the Diagnostics utility, the following message no longer displays: ACCESS
DENIED: Diagnostics, Maintenance, or Table Structure changes in process at another
station which Requires Exclusive Access to Dictionary!

(12/13/2022)(12.6.0.16) Diagnostics > Option Removed

e The option ‘Dictionary Rebuild” was removed, as it is no longer needed.

(3/3/2023)(12.6.0.16) PracticeWatch Setup > Task (Function) > ADDED: Ledger
Validate

¢ A new function ‘Ledger Validate’ was added.

e When run, it goes through all Ledgers and Validates the entries, just as if going to the
Ledger and clicking Options > Validate Ledger.

¢ This function is not automatically set up, but is available for the user to choose to run for
their practice.
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Utility

¢ It can only be run on Sunday, as it could be memory intensive and we want to avoid
slowing down your Advantage software.

e Setting up the Function Task to Run
e From the PracticeWatch screen, click Add and select Function.
e Complete the fields:
e Function Task Name - Assign a name to the task. Example: Ledger
Validate.
¢ Description — Describe what the function will do. You may choose to enter
the same data that is in the Function Task Name field.
e Selected Function — Go down to the Function name grid at the bottom and
select ‘Ledger Validate’. This populates the name into the field above.
e Assertion - Leave blank.
e Click the check to Save.
¢ Select ‘Yes’ on the confirmation window: New Task Added successfully! Set Run
Schedules now?
¢ Click 'OK’ on the following message: This task can be only scheduled weekly on
Sundays.
e The 'PracticeWatch - Task Scheduler’ window opens with the Basic Settings already
populated. Click the check to Save.

e Function Run
e The function automatically runs on Sunday morning.

Utility > Miscellaneous Utilities

(9/20/2022)(12.6.0.16) Miscellaneous Utilities > Location Change > Several
Changes

e The following changes were made: (Request)
e After entering the Location Code you wish to change to, another window opens

with the following prompt: Select YES to convert your Inventory Table as well
otherwise NO.
e Databases added to the change:
e APPTDAILYNOTE, APPTTEMPLATESCHEDULE, LOCATIONGROUPDETAIL,
SECURITYAUDIT
* 9/6/22 When the operation is complete, the following message displays:
Location Code Update Completed Successfully!
IMPORTANT!! Please Review/Udate your Location Groups that involve Location
Codes: ABC and XYZ
e ABC and XYZ represent the From and To Location Codes that were entered.

Utility > System Administrator

(3/29/2023)(12.6.0.16) System Administrator > ADDED: Table

e Advantage Database Server Version 12:
e User MUST be running Advantage Database Server version 12 to utilize these new
Utilities.
¢ Please speak with your IT Professional to verify your version.

¢ The following Utilities were added:
e Table > Pack
e Packing the databases removes any records that were deleted, freeing up
storage space.
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Utility > System Administrator

¢ This utility allows the System Administrator to pack the databases while
other users are still in the software.

e For operations targeting a specific table, viewing but not modifying that
area of the patient’s record is allowed while the table operation is running.

e Table > Re-Index

e This is similar to running a Diagnostics with the Index Only box checked.

e This utility allows the System Administrator to Re-Index the files while other
users are still in the software.

e For operations targeting a specific table, viewing but not modifying that
area of the patient’s record is allowed while the table operation is running.

(1/12/2023)(12.6.0.16) System Administrator > System Setup > Miscellaneous
Tab > ADDED: See Below

¢ Miscellaneous section
e Soc. Sec in User 1
¢ This is a NEW field to replace the SOCSEC.flg file in the product folder.
e Upon update, if an SOCSEC.flg file exists in the product folder, this field
defaults to checked. (Request)
¢ This tells the software that you are using User #1 field on the Patient
Demographics to document the patient’s Social Security #.
e Upon saving the record, the beginning of the number is replaced
with *, and it only displays the last 4 digits.
o If the field is NOT checked, you are telling the software that you are NOT
using this to document the SSN, and it needs to display all the data.

e Account Ledger section
¢ Claim Validate
¢ This is a NEW field to replace the CLAIMVALIDATEFORCE.flg file in the
product folder.
e Upon update, if a CLAIMVALIDATEFORCE.flg file exists in the product folder,
this field defaults to checked. (Request)

e This tells the software that after posting charges to the Ledger,
when you close out, you want Claim Validation/Claim Scrubbing to
automatically run.

o If the field is NOT checked, after posting charges the staff is responsible for
selecting Validate Claim, as Claim Validation will not automatically run.

Worklists

(12/19/2022)(12.6.0.16) Global > ADDED: Final Overview

e The NEW Worklist ‘Final Overview’ was added.
e This is a quick audit and more thorough Missing Charges list.
e The Worklist may be run from any area of the software with access to Worklist.
e A ‘Final Overview’ option was also added to the ‘Things To Do’ panel on the
Provider Dashboard.
e The user is prompted for the following:
e Enter Start and End Dates for the Appointment Date range.
e Enter ID of the Provider on the Appointment.
¢ Data displayed:
e Acct - Patient Account Number
e Name - Patient Name on Appointment
e ID - Provider ID on Appointment
e Date - Appointment Date
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Worklists

e Status - Appointment Status
e ExamDate - Exam Date
e Posted - Last Posting Date on Ledger
e Double click on a patient to be taken to their account.

(12/16/2022)(12.6.0.16) Global > ADDED: Missing Charges By Login ID

e The NEW Worklist ‘Missing Charges By Login ID’ was added.
¢ Lists patients who have a signed medical record (by the current user logged in), but no
charges were posted for that Date of Service.
¢ Data displayed:
e Name - Patient Name
e Date - Exam Date
e Double click on a patient to be taken to their account.

(12/19/2022)(12.6.0.16) Global > ADDED: Unapplied Ledger Balances

e The NEW Worklist ‘Unapplied Ledger Balances’ was added.
¢ Lists patients who have an Unapplied Credit on their account.
e Data displayed:
e Acct - Patient Account Number
e Last - Patient Last Name
e Paid - Total of Unapplied Payments
e Date - Date last Unapplied Payment was made
e Double click on a patient to be taken to their account.

I.T. Specialist Information

(2/9/2023)(12.6.0.16) Ctrl Key on Launch > Online Re-Indexing

¢ Holding the ‘Ctrl’ key down on the keyboard when launching the software brings up a
diagnostics window.

¢ If running Advantage Database Server version 12, the new online re-indexing is used.

* This allows the diagnostics to run with users in the software.

(11/9/2022)(12.6.0.16) Ctrl Key on Launch > Option Removed

¢ Holding the ‘Ctrl” key down on the keyboard when launching the software brings up a
window to select from.
e The option 'R’ for Rebuild Dictionary was removed, as it is no longer needed.

(3/3/2023)(12.6.0.16) Online Re-Indexing > Advantage Database Server 12

e If running Advantage Database Server version 12, a new online re-indexing is available.
e This allows index only diagnostics to run with users in the software.
e Important things to remember:
¢ Running diagnostics during the middle of office hours will cause some performance
issues (slowing down).
e This should only be done on a “have to” basis.
e Example: It is the end of the day, 2 people forgot to log out of the software and a
diagnostics need to be run. You no longer need to “chase them down”.
e The online re-indexing includes 3 stages of processing:
e Setup
¢ In this stage, the new index files are created.
¢ Re-indexing
e Indexes are populated with the existing data of the original table.
¢ Updates made to the table and indexes during the re-indexing are also
applied to the new table and indexes.
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I.T. Specialist Information

e Transition
e This stage is where the final steps are taken to transition users from the
original table to the new index table.
e The re-index operation must wait until all updates to the table are
committed before the transition stage can begin.
e In order for a user to transition to the new table, they must make a call to
the server and reposition their record pointer.

e The server calls that can transition a user are: Goto, GoTop,
GoBottom, Skip, Seek, SetFilter, Append, SetRelativeKeyPosition,
GoScopeEnd, GetFilteredRecordCount, GetRecordCount, and
CloseTable.

e The online re-index operation does not fully complete until all users of the
table have transitioned.
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